
Log on to Information Technology - 10 (Code- 402/462, NSQF Level-2)
UNIT 1: FUNCTIONAL ENGLISH (INTERMEDIATE)

SESSION - 1 (Exercise Time)

1.  a 3.  a, the 4.  the 5.  an 6.  no article 7.  a, a 9.  a 11.  a

SESSION - 2 (Exercise Time)

A. 1.  waste my time in useless activities 2.  study two hours in a day daily 3.  complete this project

4.  never hurt the animals 5.  learn driving again 6.  tell a lie 7.  help my sister

8.  argue with her friends 9.  complete the syllabus in time 10.  catch the criminal

B. 1. a 2.  c 3.  b 4.  a 5.  c 6.  b 7.  a 8.  a 9.  b 10.  a

SESSION - 3 (Exercise Time)

1.  a.  Active b.  Passive 2.  a.  Passive b.  Active 3.  a.  Passive b.  Active

4. a.  Active b.  Passive 5.  a.  Passive b.  Active 6.  a.  Passive b.  Active

7. a.  Active b.  Passive 8.  a.  Passive b.  Active 9.  a.  Active b.  Passive

10. a.  Passive b.  Active 11. a. Passive b.  Active 12. a. Passive b.  Passive

13. a.  Active b.  Passive 14. a. Active b.  Passive 15. a. Active b.  Passive

16. a.  Passive b.  Active 17. a. Active b.  Passive 18. a. Active b.  Passive

19. a.  Active b.  Passive 20. a. Active b.  Active

SESSION - 4 (Exercise Time)

A. 1.  a 2.  b 3.  b 4.  a 5.  b 6.  b 7.  a 8.  b 9.  a 10.  b

B. 1.  who 2.  What 3.  What, you 4.  themselves 5.  ourselves 6.  I 7.  Its 8.  that

9.  themselves 10.  yourself

SESSION - 5 (Exercise Time)

A. 1.  Past 2.  Present 3.  Present 4.  Past 5.  Future 6.  Past 7.  Present 8.  Future

9.  Past 10.  Future

B. 1.  was 2.  did 3.  was, went 4.  bought 5.  grew 6.  left 7.  went 8.  was talking, passed

9.  knocked at 10.  did not do

C. 1.  Boiled 2.  Arose 3.  Fought 4.  Gave 5.  Laid 6.  Sold 7.  Swept 8.  Spoke 9.  Thrusted

10.  Wrote

SESSION - 6 (Exercise Time)

1.  enough 2.  too 3.  hard 4.  on 5.  early 6.  This 7.  brave 8.  very 9.  high 10.  sweeter

11.  but 12.  nearest 13.  historical 14.  directly

SESSION - 7 (Exercise Time)

A. Do it yourself

B. 1.  Replace with by in 2.  Replace in by of 3.  Replace of by in 4.  Remove with 5.  Add on after and

6.  Replace from by for 7.  Replace In by At 8.  Replace of by in 9.  No error

10.  Replace between by among

C. 1. by 2.  with 3.  for 4.  from 5.  beside 6.  of 7.  to 8.  in 9.  over 10.  over

SESSION - 8 (Exercise Time)

A. 1.  Yes 2.  Yes 3.  No 4.  No 5.  Yes 6.  Yes 7.  No

B. Do it yourself

SESSION - 9 (Activity)

1.  a and b 2.  a and b 3.  b 4.  b and c 5.  a and b 6.  b 7.  c 8.  a 9.  b and c 10.  a and c

(Page No: 26)

1. Past Continuous tense 2.  Past Continuous tense 3.  Present Continuous tense 4.  Present Continuous tense

5. Present Continuous tense 6.  Past Continuous tense 7.  Present Continuous tense 8.  Past Continuous tense

9. Past Continuous tense 10.  Present Continuous tense

(Exercise Time)

A. Do it yourself

B. One day my friend rang me up. It was a holiday and we decided to go to Zoo. We bought tickets and entered the 
Zoo. First of all we saw water birds, ducks and cranes in a pond and on the other side there were tigers, wolves and 
bear in a different cage. The lion was sleeping and the lioness were playing with their cubs. It all looked very fearful. 
Then we moved on and came to a glass house. There were birds of different kinds and colours and they were 
chirping. The atmosphere was very pleasant. We took a ride on an elephant and enjoyed it thoroughly. It was 
evening by this time and we were tired also. We came back home after an enjoyable day.
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C. 1.  was running 2.  was cooking, was listening to 3.  was getting 4.  were discussing 5.  was working

6.  was passing 7.  were you doing 8.  was exercising 9.  was always complaining 10.  was getting

SESSION - 10 (Exercise Time)

A. Client: I want to rent out a place of stay.

Broker: Very well, sir. What type of accomodation would you prefer?

Client: Since I am a student and live alone I would prefer paying guest accomodation.

Broker: Sorry sir, paying guest facility is not available in this area. Would you like to get in some other area?

Client: No, I want to stay in nearby area. Could you get me a single bedroom flat?

Broker: Which floor would you prefer?

Client: I would prefer first floor. But it should independence with separate kitchen and bathroom.

Broker: Could you give me an estimate for rent to be paid.

Client: It should not very expensive.

Broker: O.K. I have just such flat. But what about security?

Client: O.K. What about water and electricity bills?

Broker: It is included.

Client: Good. And what is your fee?

Broker: You would have to pay the half of first month’s rent.

Client: Can I see the room and meet the landlord to negotiate.

Broker: Of course. Let’s go.

B. 1.  shall be singing 2.  will be getting 3.  will be investigating 4.  will be waiting 5.  shall be taking

6.  will be joining 7.  shall not be taking 8.  will be raining 9.  will not be accepting

10.  will be addressing

SESSION - 11 (Activity)

A. 1, 3 B.  2 C.  2 D.  3 E.  2

(Exercise Time)

A. 1.  for 2.  of 3.  to 4.  for 5.  for 6.  of 7.  from 8.  of 9.  with, over 10.  from

B. 1.  in 2.  since 3.  untill 4.  by 5.  through 6.  from 7.  under 8.  in 9.  with, over, for, in, with

10.  by, of, over, by 11.  by, in, with 12.  for

SESSION - 12 (Activity)

1. Countable 2.  Uncountable 3.  Countable 4.  Countable 5.  Uncountable

6. Countable 7.  Uncountable 8.  Uncountable 9.  Countable 10.  Countable

(Exercise Time)

A. Policeman – Yes, How can I help you?

Complainant – Sir, my car has been lost.

Policeman – What was the make of the car?

Complainant – Sir, It was a Santro car.

Policeman – What colour was it?

Complainant – The colour of the car was Grey.

Policeman – When did you lose it?

Complainant – It was on Monday, 14th June 2018.

Policeman – When did you realise that it has been stolen?

Complainant – Sir, it was between 3 o’ clock to 5 o’ clock.

Policeman – Okay sir, we will try our best to recover it. Please give your address and contact number.

Complainant – My address is B-3/109, sector 15, Rohini and the contact number is 123456789. Please try your best 
sir. I will be very grateful to you.

B. 1.  any 2.  most 3.  little 4.  a few 5.  much 6.  more 7.  both

SESSION - 13 (Exercise Time)

A. 1.  witty 2.  earnestly 3.  vacant, dismiss 4.  wastage 5.  great

B. 1.  appreciative 2.  affected 3.  antipathy 4.  Beneficent 5.  Deserts 6.  illegible 7.  elusive 8.  enviable

9.  Honorary 10.  loose

SESSION - 14 (Exercise Time)

A. Sentences 2, 4 and 5 are in Present Perfect tense.
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B. 1.  has spent 2.  have taught 3.  have finally decided 4.  has beaten 5.  have cut 6.  has robbed

7.  has not seen 8.  have not received 9.  has just submitted 10.  has, washed

SESSION - 15 (Activity)

1. at 2.  of 3.  on 4.  by 5.  about 6.  between 7.  into 8.  on 9.  of

10.  on

(Exercise Time)

1. b 2.  a 3.  b 4.  c 5.  a 6.  a 7.  b 8.  a 9.  c 10.  a 11.  a 12.  c

SESSION - 16 (Exercise Time)

A. Sentences 2, 5, 6, 8, 9 and 10 belong to past perfect tense.

B. 1. I haven’t seen you in the park for a long time. At what time do you come?

2. I would like to come to park daily as it refreshes our tired and fatigued mind. It gives us fresh air.

3. Why don’t you come to park then?

4. I don’t come because our park is not at all well-maintained. It is so dirty and unhygienic.

5. Yes, I know. Moreover some bad elements of neighbouring locality keep playing cards (gamble) all the time.

6. No doubt it has become a hub of illegal activities for all types of evil characters and is a nuisance rather than an 
asset.

7. I am afraid  if no immediate action is taken, the park will turn into a devil’s den.

8. We must raise the issue in RWA meeting and then report to the authorities for appropriate actions.

9. O.K. See you in the next RWA meeting.

C. 1. had scored 2.  had got discharged 3.  had bought 4.  had already started 5.  had paid 6. had taken

7. had hoped 8.  had done 9.  had parked, had driven, had stolen 10.  had met

11. had clearly explained 12.  had already started

D. 1. c 2.  b 3.  d 4.  a 5.  c

SESSION - 17 (Exercise Time)

A. Reena: Mama, our summer vacations are approaching. We will visit our grandmother who is not feeling well.

Mama: My programme may be clear by the weekend only. We can leave the station only after that.

Reena: Shall we take our puppy with us?

Mama: You should not. It might be a cause of trouble to the whole family there.

Reena: That is my responsibility. You know it will not go against my wishes.

Mama: Well then, it is all right.

B. Visitor: Where is the booking counter?

Clerk: Would you mind going into the next building on your left?

Visitor: I wonder if you could also tell us the fare from Delhi to Shimla.

Clerk: You will find all the details in the cart just above the booking counter.

Visitor: Thank you. I will just find out from the chart.

C. 1. She may get in touch with you this evening.

2. You must have got my message.

3. He can’t reach there without any help.

4. You should satisfy with your son’s performance.

5. The last batch must perform their practicals.

6. Reena should be in the common room.

7. The Shatabdi Express must be a comfortable train.

8. You need not wash the car.

9. Can I use your phone?

D. 1. will 2.  should 3.  dare 4.  must 5.  will 6.  ought 7.  could 8.  will 9.  can

10.  must 11.  used to 12.  will 13.  should not 14.  should 15.  could

SESSION - 18 (Activity)

1, 5, 9, 11, 16, 20, 22 and 23

(Exercise Time)

A. Do it yourself

B. 1. when 2.  after 3.  and 4.  before 5.  except 6.  more, than 7.  if 8.  should 9.  until

10. neither, nor 11.  but 12.  because 13.  so 14.  Both, and 15.  first, then

16. No sooner, than 17.  too, to 18.  whom 19.  Hardly, when 20.  and
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SESSION - 19 (Activity)

Subject: Application for the post of guest teacher.

Contact detail of Sender: 28/3, Arya Nagar, Fatehpuri

Contact detail of Recipient: The District Education Officer.

Body of the letter:

1. I have come to know through reliable sources about the Vacant post of a guest teacher in one of your schools. I wish to 
apply for the same.

2. As regards my qualifications and experience, kindly find details below.

3. I passed the Matriculation Exam from Govt. school, Fatehpuri in 1994 with 78.2% marks.

4. I did my graduation in B. A. (pass) with 69% marks in 1998.

5. I did my B. Ed. in 1999 with 60% marks.

6. I have 2 years experience of teaching English in a High school.

7. The experience certificates are enclosed alongwith.

8. I like to assure you that if selected, I shall do my best to the satisfaction of my superiors.

(Exercise Time)

A. 1.  a 2.  d 3.  b 4.  c 5.  b 6.  a 7.  b 8.  d 9.  d

B. 1.  Anil said to me, “I will come again tomorrow”.

2.  “Do not let the children go outside”, Mr. Das asked the servant.

3.  He said to me, “How much did you pay for your car”?

4.  She said to Reena, “Did she have an extra copy”?

5.  She said, “She is suffering from fever”.

6.  “Please do not refuse leave to me”, The clerk said to the manager.

C. Do it yourself

SESSION - 20 (Exercise Time)

A. 1.  May 4.  How 6.  Why 8.  Do 10.  Which 12.  When 14.  How 16.  Have 18.  Would

20.  How much 22.  When 24.  Do

SESSION - 21 (Activity)

Sentences 2, 5, 9, 11, 13 and 15 are in Present Perfect tense.

(Exercise Time)

Caller: Hello, I am Rajeev from ABC company. I received your application for the job of a cahier. I hope I am talking to Ms 
Seema.

Seema: Yes, sir. I have applied for the same job.

Rajeev: I just read your bio-data and am glad to inform you of a vacancy.

Seema: Oh sir. I am so glad to know that you have informed me of the vacancy.

Rajeev: I understand that you did B.Com (hons) from Delhi university.

Seema: Yes sir. I have completed my B.Com (hons) from Delhi university.

Rajeev: Are you familiar with making of an inventory?

Seema: Yes sir. I have done this work before also.

Rajeev: O.K. May I know if you can handle the payment of hundreds of customers daily?

Seema: Yes. I have also handled such payments before.

Rajeev: O.K. You will be responsible for running weekly meetings for a staff of 10 employees.

Seema: I am sure I can manage that I have run such meetings before also.

Rajeev: Good and what are your salary expectations.

Seema: I was being paid ̀  1.5 Lakh annually at my previous job. I do hope for a raise.

Rajeev: Well, the management has decided to offer you ̀  2 lakh annually. Do you have any objection?

Seema: No sir. I have no objection. It will be absolutely O.K.

Rajeev: When can you join?

Seema: I have decided to join on Monday. Will that be O.K.?

Rajeev: It will be absolutely fine.

Seema: Thanks a lot, sir.

SESSION - 22 (Exercise Time)

Do it yourself
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UNIT 2: WEB APPLICATIONS (BASIC)

SESSION - 1 (Exercise Time)

I Objective Type Questions

1. a.  Assistive b.  Action, Control c.  On-screen keyboard d.  Sticky e.  Toggle f.  Magnifier g.  visual

2. a.  T b.  T c.  F d.  T e.  F

II Multiple Choice Questions. Tick (ü) the correct answer.

1. a 2.  d 3.  d 4.  a 5.  b

III Short Answer Questions.

1. The Accessibility options in Windows help to make it easier to see, hear and use computer for people with any type of 
disabilities such as cognitive impairments, visual impairment, hearing impairment and motor or dexterity impairment. 
In Windows 7 these options can be accessed from the Control Panel.

2. The Narrator is a basic screen reader that reads the content aloud as it is highlighted and describes the on-screen 
activity. It is useful for people with hearing impairment.

3. High contrast and Magnifier options are very useful for people with visual impairment. The High contrast feature helps 
to make the text and images more clear, distinct and easy to identify on the computer screen. This feature can be 
turned on from the Ease of Access Center in the Make the computer easier to see window. On the other hand, the 
Magnifier tool helps to enlarge some part or the entire screen so that a person with low-vision can easily visualize 
items on the screen.

4. Serial keys are designed to assist people that have difficulty using a keyboard or a mouse (or both). This feature allows 
such people to use special devices like Sip, Puff and Breath Switches to provide input to the computer through serial 
ports. On the other hand, the Toggle keys have been designed for people who have cognitive disabilities. When this 
feature is turned on, computer produces sound on pressing any of the locking keys (Caps Lock, Num Lock or Scroll 
Lock).

5. The Mouse Keys is a feature in Windows operating environment that allows us to control the mouse pointer by using 
the numeric keypad on our keyboard when it is turned on. This feature is useful for those people who have difficulty to 
hold the computer mouse.

SESSION - 2 (Exercise Time)

I Objective Type Questions

1. a.  Computer network b.  LAN c.  MAN d.  Peer-to-peer e.  LAN card

f.  Access point, wireless card g.  Bluetooth

2. a.  T b.  F c.  T d.  T e.  F f.  F g.  T

II Multiple Choice Questions. Tick (ü) the correct answer.

1. a 2.  c 3.  a 4.  c 5.  d 6.  b 7.  c 8.  c 9.  b 10.  b

III Short Answer Questions.

1. When multiple computers and other devices are interconnected through a wired or wireless medium to share data and 
other resources, it is called a computer network. 

2. A Local Area Network (LAN) is a small network that helps to connect computers and other devices in a limited 
geographical area like an office, building, school, etc. On the other hand, a Campus Area Network (CAN) is 
comparatively bigger network that helps to connect computers in a campus area like a university campus. Two or 
more LANs are connected to form the Campus Area Network.

3. A wireless network is a type of network in which computers are connected without wires or any physical media. In this 
network, the electromagnetic waves are used for transmission of data. 

4. Wi-Fi or Wireless Fidelity is the most popular wireless communication protocol used for homes, private business 
LANs and public hotspots. 

5. The advantages of Wi-Fi network are as follows: 

lIt can transfer data at high speed (about 11 Megabytes per second or Mbps).

lIt has a long range (1000 ft. / 305 m in open areas, 250 to 400 ft. / 76 to 122m in closed areas). 

lIt is reliable. lIt can be easily integrated into the existing wired-Ethernet networks. 

6. Bluetooth is a wireless protocol used to wirelessly link mobile phones, computers and other network devices over 
short distances, typically up to 30 feet or 10 meters. 

7. In Infrared network, devices communicate through short-range wireless signals. With infrared, computers can 
transfer files and other digital data bi-directionally. 

8. Two limitations of a Bluetooth network are as follows: 

1. In a Bluetooth network, the speed of data transfer is very slow (1 Mbps approx.). 

2. The range of Bluetooth is only about 10 meters. 
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9. Bluetooth wireless network v/s Wi-Fi wireless network

a. The range of a Bluetooth network is about 30 feet or 10 meters whereas the range of a Wi-Fi network is about 100 
feet or 31 meters. 

b. The speed of data transmission in a Bluetooth network is 1 Mbps (1 Megabits per second) whereas the speed of 
data transmission in a Wi-Fi network is about 11 Mbps (11 Megabits per second).

10. In Infrared network, signals cannot penetrate walls or other obstructions and work only in the direct line of sight. 

11. The Internet is a system of linked networks spread throughout the world. It is the biggest network that facilitates data 
communication services. 

12. Personal Area Network (PAN), Local Area Network (LAN), Campus Area Network (CAN), Metropolitan Area Network 
(MAN) and Wide Area Network (WAN).

13. Peer-to-peer networks and Client-server networks.

14. Wireline networks and Wireless networks.

15. Radio waves, infrared signals, Bluetooth and Wi-Fi technology etc.

16. Wireless Access point and Wireless LAN card.

17. Up to 30 feet or 10 meters.

18. 1000 feet or 305 meters

19. a. Local Area Network b. Campus Area Network c. Global Area Network               d. Wireless Fidelity

e. Megabits per second f. Wireless Local Area Network

20. A computer network is needed to make communication and resource-sharing easy and cheap. It needs to be setup at 
places where a large number of people working with computers need to share information, costly resources like 
hardware devices and software. In a networked environment, any user can access the information, programs, 
hardware resources like printers, scanners, modems, hard drivers, CD-ROM drives, etc. and software resources like 
files, applications, any programs, games, etc. easily and use them. A network also helps its users to communicate with 
each other via emails, instant messaging, video conferencing, etc. It helps an individual or an organization to save 
time and money both.

21. Three advantages of creating computer networks are as follows:

1. A Computer network helps the users to share costly hardware and software resources. Thus, it avoids purchasing 
hardware devices for separate computer. Users can also access the licensed software installed on a central 
computer called Server. 

2. In a computer network, backups of important and crucial information may be kept on several machines, so that if 
one computer is out of order, information can be retrieved from another. 

3. In a networked environment users can communicate with each other via emails, instant messaging, video calling, 
etc. 

22. Computers can be of three main types on the basis of their geographical span – LAN, MAN and WAN. 

LAN or Local Area Network: A Local Area Network (LAN) is a computer network that covers a relatively small area. 
Most LANs are confined to a single building or a group of buildings in a fewer kilometers. LANs are generally used to 
connect workstations and personal computers. The speed of data transmission in a LAN is faster. LANs are generally 
owned by individuals (persons or organizations) for example, a LAN in an office or a LAN in a school etc. 

MAN or Metropolitan Area Network: A Metropolitan Area Network (MAN) connects computers and other networking 
devices placed at different locations in a big city or town. It can connect two or more local or campus area networks 
together. The geographical area of a MAN is larger than that of a LAN but smaller than a WAN. A MAN is typically 
owned and operated by a single organization, by a government body or a large company. 

WAN or Wide Area Network: A Wide Area Network or WAN is a computer network that spans over large geographical 
area such as a country or even over in continental distances. In a Wide Area Network, microwaves and satellites are 
normally used as the communication channel. 

23. Two advantages of wireless networks are as follows:

1. Wireless networks provide more flexibility as the connected computers need not be fixed at a place.

2. It makes possible to provide connectivity in the remote and rural areas where it is very difficult to lay cables.

24. Two limitations of wireless networks are as follows:

1. In Wireless networks, there are greater chances of radio interference due to weather conditions, other wireless 
devices, or obstructions such as walls.

2. Data transfer rates drop as distance increases or if the number of computers using the network increases.

25. A Broadband is a type of Internet connection that allows us to connect our computer to the Internet and use its 
services. It provides faster data transfer speed than the traditional dial-up connection.

26. A client-server network is one in which all other computers (called clients) of the network are connected to the main 
powerful computer (called server). In this type of network, the server offers services to the client computers upon their 
requests.
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27. The differences between LAN and WAN are as follows:

SESSION - 3 & 4 (Exercise Time)

I Objective Type Questions

1. a.  Instant messaging b.  Internet connection, IM software, Microphone

c.  Application based instant messaging d.  Gmail e.  Web

2. a.  T b.  T c.  F d.  F e.  T

II Short Answer Questions.

1. 1. Google Talk 2.  Yahoo! Messenger 3.  Skype 4.  Windows Live Messenger 5.  Rediff Bol

2. Instant messaging (IM) is a form of communication over the Internet that offers an instantaneous transmission of text-
based messages from sender to receiver.

3. 1. Messages should be short and to the point.

2. Always introduce yourself by name if your screen name doesn’t reflect it.

3. Always ask if the other person has time to chat first - regardless of how important you think what you have to say is, 
it’s not going to be well received if the recipient is busy.

4. The basic needs to use instant messaging software are as follows:

lA multimedia computer lInternet connection

lWeb browser to use web based instant messaging software

lA valid account on instant messaging software lMicrophone and speakers for making audio or video call.

5. A web-based IM software can only be accessed and used through a web browser software whereas an Application-based 
IM software is directly downloaded on the user's computer and does not require a web browser software to run on.

6. Google Talk is a popular instant messaging software that can be downloaded and used on the computer for real-time 
conversation. It is developed by the Google Inc.

SESSION - 5 & 6 (Exercise Time)

I Objective Type Questions

1. a.  Blog Address b.  photos, videos, etc. c.  web browser, blog address d.  email address e.  comment

2. a.  F b.  F c.  F d.  T e.  T

II Multiple Choice Questions. Tick (ü) the correct answer.

1. a 2.  d 3.  d 4.  b

III Short Answer Questions.

1. Blog is a short form for the word Weblog. It is a frequently updated online personal journal or diary. It is a place to 
express ourself to the world. Blogs are useful as they allow us to connect with the people around the world and know 
their views on various topics.

2. 1. www.WordPress.com 2.  www.blogger.com 3.  www.blog.com 4.  www.weebly.com

5. www.blogsome.com

3.
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Local Area Networks (LAN) Wide Area Networks (WAN)

1. Local Area Networks are small networks of computers. 1. Wide Area Networks, or WANs are very large networks of 
computers.

2. These networks span in small geographical area, 
generally within 1 to 5 km of range.

2. These networks span large geographical areas, 
generally covering a couple miles, sometimes 
connection computers thousands of miles apart.

3. A LAN does not consist of any other type of network. 3. A WAN normally consists of many small or large LANs.

Blog

1. It is a personal website created and managed by an 
individual.

2. The content of a blog is dynamic. It is updated by the 
blogger on a regular basis.

3. On a blog site the posts are listed in a chronological order.

4. It provides a comment box at the last of the page to get 
suggestions of the visitors.

Website

1. A website can be personal, commercial, government or 
non-profit organization website, etc.

2. The content of most websites remains static. It is updated 
or changed by the web developers.

3. There is no chronological order of text on a website.

4. It may provide you options to give your feedback but not 
necessary.



4. 1. Thingamablog 2.  Windows Live Writer 3.  Blog desk

5. We can use the offline blog editors to create our blogs even when there is no internet connectivity. They provide us 
many tools and options to create effective blogs.

6. There are hundreds of websites such as wordpress.com, blogger.com, etc. that offer blog service for free. Steps to 
create a new blog account on wordpress.com are as follows:

1. Open the Web Browser.

2. On the address bar type https://wordpress.com.

3. Enter Blog Address: You must provide a unique address to  your WordPress Blog.

This is the address which others will use to view your blog.

4. Enter username and password.

Username: choose a username for managing this blog.

Password: Securing your WordPress blog account with a strong password is important. A combination of 
uppercase and lowercase letters with some digits along with symbols would be a strong enough password. You 
need to enter the password twice.

5. Provide Email Address. You must provide your Email Address here. An activation link will be sent to you from 
WordPress after you click “Continue”.

6. Open your email and click on the activation link. Once you click Activate Blog, you will be redirected to your 
WordPress Blog Account.

SESSION - 7 & 8 (Exercise Time)

I Objective Type Questions

1. a.  Electronic commerce b.  active internet connection c.  online stores d.  Antivirus, Antispyware

e.  Firewalls f.  Cookies

2. a.  F b.  F c.  T d.  F e.  T

II Multiple Choice Questions. Tick (ü) the correct answer.

1. a 2.  d 3.  c 4.  a 5.  b 6.  d

III Short Answer Questions.

1. Online transactions make it possible to perform the commerce activities by using the Internet. We can pay for goods 
and services through online transactions.

2. Three advantages of online transactions are as follows:

1. Online transactions make it possible for seller to sell their products directly to the buyer. Also, the buyer can 
purchase goods or use any services at their home comfort.

2. It saves time and money of both parties.

3. It helps to provide services to the rural and remote areas.

3. Flipkart, Amazon, Indiamart, IRCTC and e-banking sites of various banks.

4. 1. Credit/debit card 2.  Net-banking 3.  Cash on Delivery

5. Internet security is a branch of computer security specifically related to the Internet. It involves browser security but 
also network security on a more general level, as it applies to other applications or operating systems as a whole. Its 
objective is to establish rules and measures to use against attacks over the Internet.

6. Malware such as (viruses, worms, trojans, etc.), spyware, phishing, cookies, etc. are common online threats.

Trojan: Trojan is one of the most complicated threats among all. Most of the popular banking threats come from the 
Trojan family such as Zues and SpyEye. It has the ability to hide itself from antivirus detection and steal important 
banking data to compromise your bank account. If the Trojan is really powerful, it can take over your entire security 
system as well. As a result, a Trojan can cause many types of damage staring from your own computer to your online 
account.

Virus: Looking at the technology 10 years back, Virus is something really popular. It is a malicious program where it 
replicates itself and aims to only destroy a computer. The ultimate goal of a virus is to ensure that the victim’s computer 
will never be able to operate properly or even at all. It is not so popular today because Malware today is designed to 
earn money over destruction. As a result, Virus is only available for people who want to use it for some sort of revenge 
purpose.

Worms: One of the most harmless threats where it is program designed only to spread. It does not alter your system to 
cause you to have a nightmare with your computer, but it can spread from one computer to another computer within a 
network or even the internet. The computer security risk here is, it will use up your computer hard disk space due to the 
replication and took up most of your bandwidth due to the spread.
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Spyware: It is a Malware which is designed to spy on the victim’s computer. If you are infected with it, probably your 
daily activity or certain activity will be spied by the spyware and it will find itself a way to contact the host of this 
malware. Mostly, the use of this spyware is to know what your daily activity is so that the attacker can make use of your 
information. Such as if you browser on travel sites for a week every day, the attacker will try to come out with a 
fraudulent travel deal to cheat on your money.

Phishing: A fake website which is designed to look almost like the actual website is a form of phishing attack. The idea 
of this attack is to trick the user into entering their username and password into the fake login form which serves the 
purpose of stealing the identity of the victim. Every form sent out from the phishing site will not go to the actual server, 
but the attacker controlled server.

Cookies: Cookies is not really a Malware. It is just something used by most websites to store something into your 
computer. It is here because it has the ability to store things into your computer and track your activities within the 
site. If you really don’t like the existence of cookies, you can choose to reject using cookies for some of the sites 
which you do not know.

7. Encryption enhances the security of a message by scrambling its content. It is the most effective way to hide 
communication via encoded information where the sender and the recipient hold the key to decipher data.

8. A computer firewall controls access between networks. It generally consists of gateways and filters which vary from 
one firewall to another. Firewalls also screen network traffic and are able to block traffic that is dangerous. Firewalls 
act as the intermediate server between SMTP and Hypertext Transfer Protocol (HTTP) connections.

9. Taking backup of data means copying the data from the computer's hard disk to an external storage medium such as 
CD, DVD, external hard disk, etc. This could be helpful in situation when there is a loss of data.

10. Cookies are small files that are stored on the user's computer by the web developer to know their activity on the 
Internet. They are designed to be a reliable mechanism for website to remember stateful information or to record the 
user's browser activity.

11. A digital certificate also known as public key certificate is an attachment to an electronic message used for security 
purposes. The most common use of a digital certificate is to verify that a user sending a message is who he or she 
claims to be, and to provide the receiver with the means to encode a reply.

12. Some characteristics of a strong password are as follows:

lA strong password should be at least 12-14 characters long.

lIt should contain both upper and lower-case letters.

lIt should also include numbers and a special symbol (@, #, $, %, etc.).

13. Three ways to protect our data from online threats are as follows:

1. We should install and use good antivirus, antispyware and firewall software on our computer to protect data from 
online threats. They should also be updated on the regular basis to identify and remove newly created malware.

2. We should use a strong password for our user ids that we create on different email, social networking or other 
sites. We should also protect our computer with a password.

3. We should turn on the security protection provided in the browser settings. Also, delete the cookies from the 
computer regularly.

14. An Antivirus software helps to identify and remove viruses from the computer whereas an antispyware software helps 
to identify and remove spyware software from the computer.

15. Three ways to ensure secure online transactions are as follows:

1. Backup the data: Always keep copies of personal data in additional media such as compact discs, pen drives, 
etc. This could be helpful in situation when there is a loss of data. Keep the data away from unauthorized users.

2. Use encryption software: Usually available within the operating system to protect the data from unauthorized 
users. If encryption software is not available within the operating system, use a 3rd party software.

3. Secure transactions: If you are using online shopping or transactions, websites even store your credit card or 
online banking personal information such as your credit card number, account details, etc. This information can be 
tracked and used by un-authorized users often known as hackers to misuse this information. Again, ensure th 
website is legitimate and uses secure practices for performing and maintaining online transactions.

UNIT 3: WORD PROCESSING (INTERMEDIATE)

SESSION - 1, 2 & 3 (Exercise Time)

I Objective Type Questions

1. a.  Home b.  Insert c.  Top d.  Bottom e.  Before

2. a.  T b.  T c.  T d.  F e.  T

II Multiple Choice Questions. Tick (ü) the correct answer.

1. b 2.  d 3.  d 4.  a 5.  c
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III Short Answer Questions.

1. Three advantages of organizing text of a document in paragraphs are as follows:

1. Paragraphs provide a structure to the document and make it easy to type and read the text of a multi-page 
document.

2. We can apply different formatting features on different paragraphs to make the required text look distinctive from 
the other text.

3. We can move or copy the complete paragraph(s) within the same or different document if it is required.

2. Paragraph spacing is the amount of space between two paragraphs of a document whereas Line spacing is the 
amount of space between the lines of the same paragraph.

3. Header is text or graphics which is printed in the top margin of each page of a document. Headers are normally used to 
print page numbers, running titles, the date or the time of printing of a document, a company logo, the document’s title 
or file name, contact numbers, fax numbers, E-mail ID, etc.

4. A Footer is a text or graphic that is printed at the bottom margin of each page of a document. Footers are useful to give 
a repeated text or graphics at the bottom on every page of a multi page document. It is normally used to give page 
numbers, telephone number, email id, section number, chapter name in books etc. 

5. Steps to change the line spacing in a document are as follows:

1. Right-click the first paragraph and choose Paragraph option from the shortcut menu.

2. Click the down arrow to open the line spacing drop-down list and choose Single, Double or Multiple from the line 
spacing drop down menu. Notice the change in the preview pane.

3. Click OK to apply the new line spacing.

6. Steps to edit the header text are as follows:

1. Click on the Insert tab.

2. Click on the Header button in the Header & Footer group.

3. Select Edit Header from the pop up menu. The header section becomes editable.

4. When you are finished modifying the header, click on the “Close Header and Footer” button on the Design tab in 
the toolbar at the top of the screen.

7. We can edit or change the footer text anytime as per the requirement of the document in which it is given Editing a 
footer is quite simple as shown in the steps below:

1. Double-click below the bottom margin even when the footer does not already contain text or other content.

OR

lYou can also select Footer in the Header & Footer group on the Insert tab of the Ribbon and then Edit Footer 
option.

2. To close the footer and return to the document, you can use the large red Close Header and Footer button on the 
Header & Footer Tools Design tab.

8. Steps to give different header text on even and odd pages of a document are as follows:

1. Click the Page Layout tab on the ribbon.

2. In the Page Setup group, click on the Page Setup Dialog Box launcher.

3. When the Page Setup dialog box appears, click on the Layout tab.

4. Check the Different odd and even checkbox.

5. Click on the OK button.

6. Now, modify the header for even pages on an even page and odd pages on an odd page.

7. Close the header sections after finishing.

9. To remove a header, double click on the Header area, select the header text and press the Delete key and click the 
Close Header button in the Design tab. The Header will be removed from the pages/section of the document for which 
it was set.

OR

To remove a header, choose Header ® Remove ® Header.

10. Footer can be removed from a document by following the steps given below:

1. Select the Insert tab in the toolbar at the top of the screen.

2. Click on the Footer button in the Header & Footer group.

3. Select Remove Footer from the pop up menu.

Log on to Information Technology (Code - 402/462) - 10 10



SESSION - 4, 5 & 6 (Exercise Time)

I Objective Type Questions

1. a.  Style b.  Home c.  Paragraph d.  a e.  ¶ f.  Template g.  Section h.  Page Layout

2. a.  F b.  T c.  F d.  T e.  F

II Multiple Choice Questions. Tick (ü) the correct answer.

1. a 2.  b 3.  d 4.  a 5.  c

III Short Answer Questions.

1. A Style is a set of formatting characteristics such as font name, size, colour, paragraph alignment and spacing etc. that 
we can apply in a single step to any text of a document or to the entire document.

2. Different types of Quick Style provided in MS-Word are – Character styles, Paragraph styles, linked style, Table styles 
and list styles.

3. A Character style contains settings that specify the formatting of characters, such as the font name, font size, 
underlining, bold formatting, italic formatting, text color, borders, and shading. These styles are also called as quick 
styles. On the other hand, a Paragraph style contains settings that specify the formatting of paragraphs, such as text 
alignment, tab stops, indentation, line spacing, borders and the default character formatting for text in a paragraph.

4. A Template is a readymade layout provided in MS-Word. It helps us to easily and quickly create a particular type of 
document such as Agendas, Notices, Resume, Invoice, etc. with the correct layout.

5. A Section break is a break that can be added to a document to apply different formatting to different text. The Section 
breaks give us additional options for formatting our document. Especially with lengthy documents, section break is 
useful for following purpose:

lIt allows to add different headers or footers to certain parts of document.

lIt allows to print text divided in sections in portrait or landscape orientation.

lIt allows multiple main sections or chapters in one document to each start on an even or odd-numbered page.

lA certain amount or section of text can be displayed in columns, while the rest of the text remains in a single 
column.

6. Both Page break and Section break add a page in a document, However, section breaks offer more options and more 
flexibility for formatting. The differences between the two types of break is that after giving a Page break, the page 
formatting of the previous page (e.g., margins, orientation) is retained whereas after a Section break, text can be 
formatted differently from the previous text or page (e.g., columns, margins, orientation) etc.

7. There are four types of section breaks Next Page, Continuous, Even Page and Odd Page. Each offers a different 
option for formatting in the document.

Next Page: Inserts a new page or continues text on the next consecutive page.

Continuous: Starts a new section without adding a page. A common use of this type of section break is for columns.

Even Page: Inserts a new even-numbered page or continues text on the next even-numbered page.

Odd Page: Inserts an odd-numbered new page or continues text on the next odd-numbered page.

8. To add a section break, follow the steps given below:

1. Place your insertion point where you want the section break to appear.

2. Click the Page Layout tab. 3. Select the Breaks option is the Page Setup group.

4. Choose the appropriate option from the Breaks option.

9. Steps to open a template are as follows:

1. Click on the Microsoft Office button      in the top left of the Word window.

2. Click on Open from the pop-up menu. 3. In the left window, click on Trusted Templates.

4. Select the template that you wish to open. 5. Click on the Open button.

10. Even page section break inserts a new even-numbered page or continues text on the next even- numbered page 
whereas Odd page section break inserts an odd-numbered new page or continues text on the next odd-numbered page.

SESSION - 7, 8, 9 & 10 (Exercise Time)

I Objective Type Questions

1. a.  Embedding, Linking b.  destination c.  attractive, presentable d.  Illustrations

e.  within, Picture button f.  Wrap text

2. a.  T b.  T c.  F d.  F

II Multiple Choice Questions. Tick (ü) the correct answer.

1. d 2.  a 3.  c

Log on to Information Technology (Code - 402/462) - 10 11



III Short Answer Questions.

1. 1. 2.

2. In a Word processing software, elements such as graphics, charts, drawings, sounds, videos, etc. that can be 
generated as a computer file are called Objects. They can be inserted by using the required command buttons given 
under the Insert tab.

3. 1. Square 2.  Tight 3.  Behind text

4. Text wrapping is a feature supported by word processors that enables us to surround a picture or diagram with the text. 
The text wraps around the graphic object inserted in the document.

5. The Square text wrap option is used to wrap text around a square border of an inserted image whereas the Tight text 
wrap option is used to wrap text around an irregularly shaped image.

www.openclipart.org www.pdclipart.org

UNIT 4: SPREADSHEET (INTERMEDIATE)

SESSION - 1, 2 & 3 (Exercise Time)

I Objective Type Questions

1. a.  AutoSum b.  Freeze Panes c.  Hide d.  Conditional formatting e.  Manage Rules

2. a.  T b.  F c.  F d.  T e.  T

II Multiple Choice Questions. Tick (ü) the correct answer.

1. c 2.  a 3.  b 4.  b 5.  a 6.  b

III Short Answer Questions.

1.

2. The Conditional formatting is tool that allows us to create a condition for the values in the cell, and if the condition is 
satisfied then automatically the formatting of the cell changes. It is useful to quickly apply formatting to certain cells or 
range of cells to identify them easily.

3. When we work with large worksheets, once we scroll down, the heading row disappears and we can no longer be sure 
what each column contains. To overcome this problem, we can use Freeze panes feature available in Excel.

4. To hide a row or column, do the following:

1. Open a new spreadsheet.

2. Select the required row in the spreadsheet.

3. Click on Home tab on the ribbon.

4. Click on Format button available under Cells group in the Home tab.

A drop-down list appears as shown below.

5. Click on Hide & Unhide ® Hide Rows or Hide Columns.

...The selected row or column will hide.

5. We can easily unhide a row or column that is hidden. To do so follow the steps are as follows.

1. Select the rows or columns that have a hidden row or column between them.

2. Click on the Format button and point to Hide & Unhide option.

3. Click on Unhide Rows or Unhide Columns option from drop down menu.

The AutoSum feature is used for adding the values given in cells automatically without writing the formula to perform 
the operation. It automatically selects the values around the cells either horizontally or vertically.

SESSION - 4 & 5 (Exercise Time)

I Objective Type Questions

1. a.  horizontally b.  Page Layout c.  horizontal d.  vertical e.  Page Setup, Page Layout

f.  Portrait, Landscape g.  Page Setup h.  Page Break i.  Set Print Area j.  Normal

2. a.  T b.  F c.  F d.  F e.  F

III Short Answer Questions.

1. The Page Breaks are used to divide a worksheet into separate pages for printing. We can print the exact number of 
pages by adjusting page breaks in a worksheet.

2. 1. To observe the page breaks inserted in the worksheet. — View worksheet in Page Break preview.

2. To find how much area of worksheet can be printed on one A4 size paper. Set Print Area

3. To increase the left Margins of the paper before printing. Select Margins from Page Setup dialog box.

4. To print data in landscape orientation. Select Orientation option under Page Layout tab.

3. Different options available under the Page Setup dialog box are as follows:

Page: Under the Page tab two things needs to be specified – Page Orientation and Page Size.

— 

— 

— 
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a. Orientation: The orientation tab lets us change the orientation of our spreadsheet to Portrait or Landscape.

b. Size: This button lets us select the size of the paper we will print our spreadsheet on.

Margins: In the Page Setup dialog box, the Margins tab lets us set the margins that we need to set for printing our 
document. We can also set custom margins by clicking the custom margins selection at the bottom of the Margins 
button.

Header/Footer: This option helps us print a particular row of the worksheet as a header text on every printed page of 
the worksheets.

Sheet tab: The last button in the Page Setup window is the Sheet tab. Under it, the Print titles option allows us to 
repeat rows or columns on each page when we print multiple page spreadsheets.

4. To insert Page Break in a worksheet, first place the cell pointer to the row/column where you want to insert Page break 
and then follow the steps given below:

1. Click on the Page Layout tab. 2. Select Breaks button.

3. Select ‘Insert Page Break’ option from the drop down menu.

4. Observe the Page break inserted in the worksheet at cell pointer position.

5. Steps to remove a page break are as follows:

1. Click on the Page Layout tab. 2. Select Breaks button.

3. Select Remove Page Break option from the drop-down menu.  ...The Page Break will be removed.

SESSION - 6 & 7 (Exercise Time)

I Objective Type Questions

1. a.  Workbook views b.  Normal c.  Page Layout d.  Custom Views e.  Range Name

f.  Defined Names, Formulas

2. a.  T b.  F c.  T d.  F e.  T

II Multiple Choice Questions. Tick (ü) the correct answer.

1. a 2.  d 3.  d

III Short Answer Questions.

1. 1. Normal view 2.  Page Layout view 3.  Page Break preview 4.  Custom views 5.  Full Screen view

2. The Page Layout View allows us to view the way a page will look on paper before we print it out. It is helpful for the 
addition of headers and footnotes.

3. To exit Full Screen, simply right click on the mouse and click on “Close Full Screen”.

4. Range Name is a descriptive name assigned to a cell or cell range in Excel 2007 to help make formulas in the 
worksheets much easier to understand and maintain.

5. 1. The first character must be a letter, an underscore, or a backslash.

2. No spaces are allowed in a range name.

3. Do not use a name that is the same as a cell address. For example, we can’t name a range U2 or Ub40, but 
BLINK182 and ABBA are just fine.

SESSION - 8, 9 & 10 (Exercise Time)

I Objective Type Questions

1. a.  Charts b.  Embedded c.  Line d.  Pie e.  Bar f.  Data Labels g.  Sort by

h.  Filter i.  Link

2. a.  T b.  T c.  F d.  F e.  F f.  F g.  T h.  F i.  F j.  T

II Multiple Choice Questions. Tick (ü) the correct answer.

1. b 2.  a 3.  c 4.  d 5.  b 6.  d

III Short Answer Questions.

1. Anil should create the Line Chart.

2. Malti should use the Sort command button given in the Sort & Filter group of Home tab.

3. F11 function key.

4. a. A Column chart uses vertical bars or columns to display values over different categories. They are excellent tool 
for showing variations in value over time. The Bar chart is similar to a column chart but it uses horizontal bars 
instead of vertical bars. It emphasizes the comparison between items at a fixed period of time.

b. A Pie chart can display only one data series whereas a Doughnut chart has the ability to display more than one 
data series.

5. A Chart is the visual representation of data that helps a user to easily understand, analyze and compare data.

6. 1. Column chart 2.  Line chart 3.  Pie chart 4.  Bar chart 5.  Area chart
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7. The steps to create a chart are as follows: 

1. Enter your data in columns with the title for each data series at the top. 

2. Select the data that you want to include in the chart. 

3. Click on the Insert tab. In the Charts group, select a chart type from the available categories of chart types. For 
example, if you click on the Column chart type, a drop down menu listing 2-D column and 3-D column charts 
appears, you can select a type from them. 

...The selected chart will be inserted in the worksheet.

8. We should prefer to create a pie chart when displaying information about the different parts of the whole or the 
percentage of a total using one data series.

9. In Excel charts can be embedded in the same worksheet or they can be saved as separate chart sheet in a workbook.

10. A legend identifies a data series. It describes a data series represented in a particular colour on the chart.

11. Sorting is a feature in Excel 2007 that helps us arrange the selected data either in an ascending or descending order.

12. Filter is a feature used for extracting particular data using some conditions.

13. A bar graph is very similar to a line graph in the sense that it is designed to show different values of two or more 
subjects but instead of using lines it uses horizontal and vertical bars that represent a different values. There are 
numbers along the side of a bar graph and they are scales identical to what would be found on a line graph. In a way, 
this type of graph is somewhat easier to read than a line graph and it conveys information equally as well.

14. The XY (Scatter) charts are useful for showing a correlation among the data points that may not be easy to see from 
data alone.

UNIT 5: DIGITAL PRESENTATION (INTERMEDIATE)

SESSION - 1, 2, 3 & 4 (Exercise Time)

I Objective Type Questions

1. a.  Charts b.  Tables c.  Design, Layout d.  Movie

2. a.  F b.  T c.  F d.  T

II Multiple Choice Questions. Tick (ü) the correct answer.

1. d 2.  c 3.  d 4.  a 5.  d 6.  c 7.  c 8.  a 9.  a 10.  c 11.  d

III Short Answer Questions.

1. A Placeholder is used to hold text and other type of contents such as graphics, table, chart, movie, sound, etc. on the 
slide.

2. A slide layout is an arrangement of placeholders for slide content. Every slide has a slide layout that controls how the 
information is arranged on the slide.

3. 1. Select the slide where you want to insert the table.

2. Select the Insert tab on the Ribbon.

3. Click the Table command. A drop down menu with Table grid will appear.

4. Drag your mouse over the diagram squares to select the number of columns and rows in the table.

5. Enter text into the table.

4. Slide Show view.

5. A movie can also be inserted in a presentation through the Clip Organiser by following the steps given below.

1. Select the slide where you want to insert a movie clip.

2. Select the Insert tab.

3. Click the Movie command in the Media Clips group.

4. Select the Movie from Clip Organiser option from the menu. The Clip Art task pane will appear on the right.

5. Enter keywords related to the movie that you want to insert in the search field.

6. Click Go. Movie clips that meet the keyword search will appear in the task pane.

7. Click a desired clip to insert it on the slide.

6. Follow the steps given below to insert a movie from a file in a slide.

1. Select the slide where you want to insert the movie.

2. Select the Insert tab.

3. Click the drop-down arrow on the Movie command in the Media Clips group.

4. Select the Movie from File... option from the menu. The Insert video dialog box will appear.

5. Locate the file you want to insert from your computer and click the file name.

6. Click Insert. The movie will appear on the slide.
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7. Steps to insert a sound clip in PowerPoint presentation are as follows:

1. Click on the Insert tab of the ribbon.

2. Click the drop down arrow under the Sound icon in the Media Clips group.

3. Select Sound from File... option to open the menu.

4. Locate the required sound clip and select it.

5. Click ‘OK’ to insert the sound file on slide.

8. We can insert a table on a slide having a title and content layout using the steps given below:

1. Insert a slide with a content placeholder.

2. Click the Insert Table icon in the content placeholder. The Insert Table dialog box will appear.

3. Enter the number of columns and rows in the dialog box.

4. Click OK. The table will appear on the slide, the Design and Layout tabs will appear on the Ribbon.

5. Enter text into the table.

9. Steps to insert a chart into a slide are as follows:

1. Click on the Insert tab and select Chart button in Illustrations group.

2. Select the chart type from the Insert Chart dialog box that appears.

3. This will place a chart on the slide that is based on dummy data. At the same time, this launches Microsoft Excel in 
a separate window containing the dummy data of the chart.

4. Click on the MS Excel window to make it active. Change data displayed in Excel worksheet and this will be 
automatically updated on the chart in the slide.

5. Close the Excel window after completing your work.

10. Steps to modify a created chart are as follows:

1. Click on the chart to select it.

2. Click on the Design tab.

3. Choose a style for the chart from Chart Styles gallery.

4. Add the chart elements such as axes, chart title, data labels, etc. from the Add Chart Element button.

5. Change the chart type from the Change Chart Type button menu.

6. To fill colours in the chart background or apply other formatting effects use the command buttons given under the 
Format tab.

SESSION - 5, 6, 7, 8, 9, 10 & 11 (Exercise Time)

I Objective Type Questions

1. a.  Visual b.  Slide transition c.  Animations d.  Transition to This Slide

e.  Fade, Dissolves, Wipes, Push, Cover, Random f.  Animation g.  Animation effects

h.  Animation i.  Grouping of objects j.  Arrange k.  Group l.  Regroup, Ungroup

m.  Speaker notes n.  Presentation views o.  Setup p.  From Beginning q.  Normal

r.  Handouts, Notes pane, Outline s.  Print what t.  Outline

2. a.  T b.  T c.  F d.  F e.  T f.  F

II Multiple Choice Questions. Tick (ü) the correct answer.

1. d 2.  c 3.  a 4.  a 5.  c

III Short Answer Questions.

1. Transition is an audio-visual effect that is applied to some or all the slides of a presentation whereas Animation is a 
visual effect applied to individual items on a slide such as the slide title, text, clip art, chart and table.

2. 1. Fade and Dissolves 2.  Wipes 3.  Push and Cover 4.  Stripes and Bars            5.  Random

3. Steps to add transition effect to slide, using sound scheme and timing options are as follows:

1. Select the slide you wish to add a transition to. In the Animations tab under the Transition to This Slide group 
choose an effect from the Transition gallery. Use the arrow to scroll through the options. PowerPoint will show you 
a preview of the transition when you hover your mouse over a gallery item.

2. To set the speed of a transition, select a speed from the Transition Speed pull-down menu.

3. To add a sound effect to the transition choose a preset sound from the Transition Sound pull-down menu or 
choose “Other Sound” to use a sound from your computer. PowerPoint also provides an option to loop the chosen 
sound.

4. To apply the transition settings to all of the slides, click Apply To All.

5. You also have the option to customize how your slide advances. You can advance slides by clicking the mouse of 
the “On Mouse Click” option is checked, or choose to have your slide automatically advance after a certain time. 
You can even have both options checked so that you can advance the slide early if you need.
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4. Animation effects are helpful way to make your slides look very dynamic. Besides adding action, they help steer 
audience focus and emphasize important points. They are also a great way to reveal text or object on a slide one step 
at a time. For example, we could have five bullet points of text, and reveal them one-by-one on the slide with each click.

5. We can group objects on a slide to easily and quickly move, resize or reorder them at the same time. Three grouping 
options under the Group drop-down menu are Group, Regroup and Ungroup.

6. Speaker notes are guided text that helps a presenter to deliver the presentation in front of the audience. The presenter 
can note important key points that he/she wishes to cover during the presentation.

7. Steps to insert speaker notes on slides are as follows:

1. Click on the View tab.

2. In the Presentation Views group, click on the Notes Page view.

3. Click in the text box that displays 'Click to add text'.

4. Type the text that you want as the speaker notes.

5. Click on the Normal view button to go back to the normal view.

8. Do's and Don'ts for an effective presentation are as follows:

Do's

1. Keep the slide simple with no more than 10-12 words per page.

2. Write in point form and not in complete sentences and include 4-5 points per slide.

3. Proof your slides for spelling mistakes, repeated words and grammatical errors that you might have made.

Don'ts

1. Do not use a complicated font.

2. Do not use too much slides in a single presentation.

3. Do not use all capital letters as it may be difficult to read.

9. Three effective techniques to review the presentation are as follows:

1. Proof your slides for spelling mistakes and grammatical errors by running Spelling and Grammar utility.

2. Remove irrelevant points or images and add required point or images during review.

3. Practice running the slide show of the presentation before showing it to the audience.

10. Steps to set up a slide show using show type, show options and show slides configuration are as follows:

1. Click on the Slide Show tab on the ribbon.

2. From the Set Up group  click on the Set Up Slide Show. The Set Up Show dialog box opens.

3. Under Show type section, choose an option from the following by clicking on the radio button that appears before 
each option.

lPresented by a speaker (full screen) lPresented by an individual (window)

lBrowsed at a kiosk (full screen)

4. Under Show options section check the checkbox for any of the following options.

Loop continuously until 'Esc': To continue running the slide show until Esc key is pressed.

Show without narration: To run the slide show without narration.

Show without animation: To run the slide show without animation.

5. Under Show slides section, choose 'All' to include all the slides in the slide show or choose From and supply 
starting and ending slide numbers to display only selected slides.

6. Click on the OK button.

11. Steps to print Handouts for a presentation, considering 4 slides to be shown on a single page in horizontal order are as 
follows:

1. Open the required presentation and click on the Microsoft Office button.

2. Select Print option from the drop-down menu. The Print dialog box opens.

3. Choose the connected printer from Name: drop-down menu.

4. Under Print range section, choose 'All' option to print all slides, 'Current slide' option to print only the currently open 
slide or provide slide range in the Slides box to print the selected slides.

5. Under Print what section choose Handouts option to print the slide handouts.

6. Under Handouts section enter 4 in Slides per page box and choose Horizontal order to print four slides on a single 
page in horizontal order.

7. Click on the OK button.

12. A presentation can be printed in the following ways:

Slides: We can choose this option to print one slide on a single page or transparent sheet.

Handouts: To print more than one slide on a single page we can print slide handouts.

Notes Page: To print the speaker notes we use this option.

Outline: To print only text with no graphics we use this option.

,
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UNIT 6: EMAIL MESSAGING

SESSION - 1, 2 & 3 (Exercise Time)

III Short Answer Questions.

1. An online calendar is a calendaring software that we can use to plan our time. Anything that we store in an online 
calendar can be accessed from anywhere and anytime as it stores data online. We can also share schedules for 
meetings, appointments or important events with others using the online calendar.

2. Steps to configure an appointment in Microsoft Outlook Calendar are as follows:

1. Click Start ® All Programs Microsoft Office Microsoft Office Outlook 2007.

2. Click the Calendar icon located at the bottom left corner.

3. A Calendar interface will appear. You can create appointments and schedule of day-to-day activities using 
calendar. The application provides three views: Day, Week and Month.

4. Select either the show work week (Monday to Friday) or Show full week (Sunday to Saturday) to view the 
appropriate days in the week by selecting one of the given options. Selecting the Month view shows calendar for a 
month. You can plan your monthly schedule here. Any appointments/meetings/commitments previously set in the 
day/week view will also be reflected here.

5. Set the options for the calendar by selecting Tools ® Options. A dialog box appears as show below. Click on 
Calendar Options to see the Calendar Options dialog box.

6. In the Calendar Options dialog box make changes to the calendar by using appropriate options.

3. A recurring appointment is an appointment that repeats on a regular basis, for example, every Tuesday.

4. Three views: Day, Week and Month

5. We can categorize the appointments in time management software by giving the specific colours to the appointments. 
For example, we can use green colour for all school related activities and blue for all personal activities.

® ® 

SESSION - 4 & 5 (Exercise Time)

I Objective Type Questions

1. a.  Publishing b.  Sharing schedule of important events c.  Publish My Calendar

d.  File, Hide details of private appointments

2. a.  F b.  T c.  T d.  F e.  T

II Multiple Choice Questions. Tick (ü) the correct answer.

1. d 2.  c 3.  b 4.  c

III Short Answer Questions.

1. 1. Publish the calendar 2.  Send the calendar as the Email attachment

2. 1. It helps to share information in an office environment.

2. It allows co-workers to arrange meetings, appointments or important events as per the schedule made.

3. Follow the steps given below to share a custom calendar folder that you create:

1. In Calendar, in the Navigation Pane, right-click the calendar folder that you want to share.

2. Click Share folder name.

3. In the To box of the sharing invitation, enter the name of the recipient.

4. Optionally, change the Subject.

5. In addition, if you want to grant permissions to the recipient to change the calendar items by selecting the 
Recipient can add, edit, and delete items in this Calendar check box.

6. In the message body, type and information that you want to include.

7. Click Send.

8. Review the confirmation dialog box, and the, if correct, click OK.

4. Steps to send a calendar via email are as follows:

1. Click on Send a Calendar via E-mail option available in the Navigation Pane of the Calendar.

The Send a Calendar via E-mail dialog box appears.

2. Send either the entire calendar or particular week or day in the calendar by selecting the appropriate option.

3. Click OK.

4. Specify the E-mail address of the user to whom you want to share the calendar.

5. Click Send to send the calendar to the person.

5. We can check the Hide Details of private appointments checkbox in the Print dialog box to hide private events while 
printing a calendar.

6. There are three print styles available for printing an outlook calendar- Daily Style, Weekly Style and Monthly Style.
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SESSION - 6 & 7 (Exercise Time)

I Objective Type Questions

1. a.  Meeting b.  meeting time, duration of meeting, names of attendees c.  Send/receive

d.  Inbox e.  Accept, Tentative, Decline f.  Propose New Time

2. a.  T b.  F c.  F d.  F e.  F

II Multiple Choice Questions. Tick (ü) the correct answer.

1. b 2.  c 3.  c 4.  b 5.  d

III Short Answer Questions.

1. An online meeting is a way to communicate with people by sending them meeting requests. We can send meeting 
requests to the people and get their responses using Outlook software.

2. We can make a request for an online meeting by using the Schedule Assistant tool in Outlook 2007. Steps to do so are 
as follows:

1. On the Navigation pane click on the Calendar option.

2. Click on the File ® New Meeting Request to open the Meeting window.

3. In the Show group, click Scheduling Assistant. The Scheduling Assistant view appears.

4. To select attendees from an Address Book, click ADD ATTENDEES... » add the desired attendees    OR

To type the names of the desired attendees.

a. In the All Attendees list, click CLICK HERE TO ADD A NAME.

b. Type the desired recipient’s name Press Enter.

c. Press Enter.

5. From the small calendar on the right, click the desired meeting day.

6. From the Duration pull-down menu, select the appropriate meeting length.

7. From the Suggested Times list, select the desired meeting time.

8. In the Show group, click APPOINTMENT button.

The Appointment view appears.

9. In the Subject text box, type the appropriate information.

10. Complete the body of the message.

11. Click SEND button.

Your Meeting Request is sent and the window closes.

3. Schedule Assistant tool.

4. We can reschedule an online meeting by following these steps:

1. In the calendar, select the calendar event, such as meeting or appointment, and click Edit.

2. If this is a recurring meeting or appointment, you will also have to choose one of the following:

lEdit occurrence: Choose this option to open and  make changes to a single calendar event.

lEdit series: Choose this option to open and make changes to a series of calendar events.

3. Change any details for the meeting or appointment and then click Save if this is an appointment you created for 
yourself, or Send if this is a meeting with other attendees.

5. We can delete a meeting request by following these steps:

1. In the calendar, select the meeting and click Cancel. In the Cancel event window, click Yes to cancel the event. 
You’ll have a chance to type a message to the attendees before the meeting is cancelled.

2. If this is a recurring meeting, you will have to select one of these options when you first click Cancel:

lCancel occurrence: Choose this option to cancel the occurrence of the meeting you selected in the calendar.

lCancel series: Choose this option to cancel the meeting series.

6. An Attendee is a person to whom we want to invite for the meetings.

SESSION - 8, 9 & 10 (Exercise Time)

I Objective Type Questions

1. a.  Task b.  Subject, Start date, Due date, Status, Priority c.  Notes d.  Notes           e.  Journal entry

f.  Emails, Telephone calls, Meeting requests, Office documents

2. a.  T b.  F c.  T d.  T e.  T

II Multiple Choice Questions. Tick (ü) the correct answer.

1. d 2.  b 3.  b 4.  b

III Short Answer Questions.

1. The Task feature allows us to create a single to-do list, enhanced with reminders and tracking.
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2. Two advantages of recording journal entries are as follows:

1. It helps to keep track of documents and items such as emails, meetings, appointments, etc. that is recorded in it.

2. It automatically records items once we turned this feature on.

3. Journal entries is a feature that creates a timeline of transactions like emails, tasks, meetings, appointments, etc. that 
can be linked to a contact.

4. We can use the Notes feature to take quickly notes.

5. In Outlook online, a task is a feature that allows users to create a single to-do list, enhanced with reminders and 
tracking whereas Notes is a feature that is used to take quickly notes.

UNIT 7: DATABASE DEVELOPMENT (BASIC)

SESSION - 1, 2, 3 & 4 (Exercise Time)

I Objective Type Questions

1. a.  Database b.  Database Management Software (DBMS) c.  RDBMS

d.  Microsoft Access, Open Office Base, Oracle e.  Table f.  Record g.  Field h.  Data types

i.  Primary key j.  openoffice.org k.  OpenOffice Base

2. a.  F b.  F c.  T d.  T e.  F f.  T g.  T h.  F

II Multiple Choice Questions. Tick (ü) the correct answer.

1. c 2.  d 3.  c 4.  c 5.  a

III Short Answer Questions.

1. DBMS stands for Database Management Software and RDBMS stands for Relational Database Management 
Software. In RDBMS data is organized in relational tables.

2. Data types used in a DBMS/RDBMS (Open Office Base) are as follows:

1. Numeric Types: Yes/No, Tiny Integer, Small Integer, Integer, Big Integer, Number, Decimal, Real, Float and 
Double.

2. Alphanumeric Types: Memo, Text (fix), and Text.

3. Binary Types: Image, Binary (fix), Binary.

4. Date/time: Date, Time and Timestamp.

5. Other Variable types

3. Numeric Types: Yes/No, Tiny Integer, Small Integer, Integer, Big Integer, Number, Decimal, Real, Float and Double.

Alphanumeric Types: Memo, Text (fix), and Text.

4. Binary Types: Image, Binary (fix), Binary.

5. a. A Table is a database object that stores information in horizontal rows (called records) and vertical columns (called 
fields).

b. A Primary key is a field in a database table that contains unique data values and which identifies the records of a 
table uniquely.

c. A row of information in a table is termed as a Record.

6. Data types of a field determine which type of data (value) can be stored in that column or field.

7. A Record is a set of all data fields treated as a unit.

8. Open Office Base is a component of Open Office Software that provides tools for day-to-day database work with a 
simple interface.

9. The Navigation pane displays the icons of various database objects that we can click upon to open the corresponding 
object to work with it.

10. Some features of Open Office Base are as follows:

lOpen Office Base is a DBMS software of Open Office suite of applications that we can download and use on our 
computer with no license fees (free-of-cost).

lIt is an open source and platform independent software.

lIt provides a simple and easy-to-use interface to create databases.

lIt provides tools to create queries to retrieve the required information from the big database quickly and easily.

lWe can create forms and reports in OO base.

SESSION - 5, 6, 7 & 8 (Exercise Time)

I Objective Type Questions

1. a.  Form b.  Use Wizard to Create Form c.  Query d.  Report e.  Select          f.  Insert

g.  Update h.  Delete

2. a.  T b.  T c. F d.  T e.  T f.  F g.  T h.  F
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II Multiple Choice Questions. Tick (ü) the correct answer.

1. d 2.  b 3.  c 4.  b 5.  c

III Short Answer Questions.

1. a. A Primary key is a field in a database table that contains unique data values and which identifies the records of a 
table uniquely.

b. A Query is a database object used to extract data from one or more tables based on a specified condition or 
criteria.

c. A Form is the custom screen that provides an easy way to enter and view data in a table or query.

d. A Report is the formatted result of queries and contains useful data for decision-making and analysis.

2. INSERT statement is used to add one or more records to a database. The general syntax of the insert statement is:

INSERT INTO <table_name><column1, column2, column3...> VALUES <value1, value2, value3...>;

3. Steps to create a table in Design view in OpenOffice Base are as follows:

1. Click Create Table in Design View.

2. Define the Field names, data types and Field properties for the table.

3. Similarly, define all other fields, with their Field Type and Properties.

4. To access additional formatting options, click the button to the right of the Format example field. Description can 
be anything, or can be left blank.

5. To save and close the table, choose File ® Save. Name the table and close the window.

4. Steps to create a Form in Open Office Base are as follows:

1. Open the database to which you want to create a form.

2. In the database window, select the Forms tab and then click on Use Wizard to Create Form.

3. In the Form Wizard, do the following:

a. Click the Field selection step.

b. Further, select the table name.

c. Click the double right-arrow icon to move all available fields to the Fields in the form list. Click the Next button.

4. Select the Step Arrange controls and then select an arrangement of the main form, i.e., how you want to arrange 
your fields on the form, then click Next.

5. Select the step Set data entry and choose the option to use the form to enter data and leave the option to display 
data and its check boxes empty, then click Next.

6. Apply a style and field border, then click Next.

7. Name the form, select the work with the form option, then click Finish.

5. We can add records to the table through a form by following these steps:

1. Click on the New Record Symbol located at the bottom on the form navigation bar.

2. Enter the required details in each field by typing in the required data.

3. Click Next Record button to add more records to the table as desired. All the data that you enter using the Form will 
get stored in the table. You can view the added records by opening the table from the main database window.
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